Excel Exercise File
The Excel file that goes with the exercise in this guide is located to the right of the guide in the same row you downloaded the guide from.

Table of Contents
Excel Exercise File ........................................................................................................................................................................1
Table of Contents ........................................................................................................................................................................1
Sparklines ....................................................................................................................................................................................2
Creating Sparklines .......................................................................................................................................................................3
Deleting Sparklines .........................................................................................................................................................................3
Sparkline Type & Appearance ..........................................................................................................................................................4
Group & Ungroup Sparklines ..........................................................................................................................................................4
Hiding Data without Hiding Sparklines .........................................................................................................................................5
Unhide Columns ...............................................................................................................................................................................5
Conditional Formatting .....................................................................................................................................................................6
Clearing / Managing Rules ............................................................................................................................................................7
Simple Build-in Rules – Conditions Assumed from Highlighting ...............................................................................................8
Example 1: Color cells containing duplicate Student IDs ........................................................................................................8
Example 2: Color Profits that are in the Top 10% ..........................................................................................................................8
Simple Built-in Rules: Using Constants: Numeric or Text ...........................................................................................................9
Example 3: Using a Text Constant as a Condition .......................................................................................................................9
Example 4: Using a Numeric Constant as a Condition ................................................................................................................9
Built-in Rules – Using Dynamic Conditions ................................................................................................................................10
Example 5: Color Cells Above Average ...................................................................................................................................10
Using the Format Painter to Copy Rules ......................................................................................................................................11
Example 6: Using the Format Painter to Apply Rules to other Columns or Rows ........................................................................11
Example 7: Using the Format Painter to Copy a Rule to Find Overbooked Rooms .........................................................................12
Conditional Formatting using Cell Addresses and Simple Formulas .............................................................................................13
Example 1: How Referencing Works with Conditional Formatting Formulas ................................................................................13
Example 2: Color Drops in Profit (Relative Addressing) ...............................................................................................................15
Example 3: Color a Company’s Highest Profit (Mix of Relative & Absolute Addressing) ..............................................................16
Example 4: Color Entire Row where Company Average Greater than overall Average .................................................................17
Example 5: Color Rows Where Shipped Date is After Required Date ...........................................................................................18
Example 6: Color Alternating Rows .............................................................................................................................................19
Example 7: AND & OR Conditions ...............................................................................................................................................20
Range Segments – Applying Multiple Conditions to the Same Cells ...........................................................................................21
Example ..........................................................................................................................................................................................21
Icon Sets, Data Bars, and Color Scales .........................................................................................................................................24
Data Bars .........................................................................................................................................................................................24
Sparklines allow you to represent numeric data graphically in the form of a line, column, or win/loss chart that appears within a single cell. They are useful alternative to a standard Excel chart when a standard chart becomes too busy. For example, we wish to graphically display the profit for the nine companies below over the year. The top example uses Sparklines to represent the data as lines, columns, and win/loss bars while the bottom example uses a standard Excel line chart. The Sparklines are easier to read but the standard line graph does have the advantage of comparing the companies to each other more clearly.
Creating Sparklines

Sparklines represent data in a single column or row. You can create them in three ways:

- Create the Sparkline for each column or row one at a time.
- Create one of the Sparklines and then copy it (B4:M4).
- Create the Sparklines for the entire data set at once (B4:M12).

We will create a single Sparkline and then copy it.

1. Go to the "Sparklines" sheet.
2. Highlight the range: B4:M4
3. Click the "Insert" tab.
4. Click one of the Sparkline buttons. (Line for example.)

Deleting Sparklines

You will not be able to use the Delete key to remove Sparklines; instead, you must use the "Design - Clear" tab that appears when a Sparkline is selected.

1. Click the Sparkline you wish to remove. (This also makes the "Design" tab appear.)
2. Click the "Design" tab that appears.
3. Click "Clear"
4. Specify whether you wish to delete just the selected Sparkline or the entire group.
Sparkline Type & Appearance
This section covers how to switch between Sparkline types, change colors, and display dots on high points, low points, negative values, first points, last points, and markers.

1. Click the Sparkline you wish to affect. (The Design tab should appear.)
2. Click the "Design" tab.
3. See below for the different options.

Group & Ungroup Sparklines
You may have noticed that when you change formatting to one Sparkline cell, all of the other Sparklines that were involved in the original creation or the same copy get formatted as well. This is because Excel has grouped them. If you wish grouped Sparklines to have different formatting, you must first ungroup them.

1. Highlight all cells you wish to remove from the group.
2. Click the "Design" tab that appeared.
3. Click "Ungroup".

You should now be able to change the Sparklines you ungrouped individually. Note that you can also "Regroup" by highlighting cells and selecting "Group".
Hiding Data without Hiding Sparklines

When you hide the columns (or rows) containing your Sparkline data, the Sparklines also hide - even when their columns are not hidden!

To hide columns containing the Sparkline data but not the Sparklines, follow the steps below.

1. Click and drag across column letters B through M.
2. Right click anywhere within the highlighted area and select "Hide".
   (Note the Sparklines disappear.)
3. Click one of the cells that normally displays a Sparkline.
4. Click the "Design" tab.
5. Click "Edit Data" then "Hidden & Empty Cells...".
6. Check "Show data in hidden rows and columns".
7. Click "OK".
8. The Sparklines should reappear.
9. Repeat the steps above for any other Sparkline groups you wish to display.

Unhide Columns
To unhide columns:

1. Click and drag across the column letters that the hidden columns are between (A:N in this example).
2. Right click anywhere within the highlighted area.
3. Click "Unhide".
Conditional Formatting

As implied by the name, Conditional Formatting allows you to dynamically format cells based on a condition. It differs from traditional formatting in two ways:
   a. It is faster because it will instantly format only the highlighted cells which match a specific condition.
   b. It is dynamic meaning that if the cell content changes, the formatting can change automatically.

Formatting Options Available:
   • Most of the standard formatting options you would find through Control + 1 (e.g. fill, font color, bold...)
   • Data Bars.
   • Icon Sets.
   • Color Scales.

The condition can employ any of the following:
   • Value Constants – e.g. format all the cells that are greater than 5.
   • Label Constants – e.g. format all the cells that have the word Microsoft in them.
   • Cell Addresses – e.g. format all cells that contain a value greater than what is in cell B10.
   • Formulas – e.g. format all cells greater than B10+8.
   • Functions – e.g. format all cells whose contents is greater than Average(C2:C10).

The different comparison operators you can use are:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
</tbody>
</table>

The key is to use an equation or function that returns either True or False. For example: B5 >= 6

Some examples of functions are:

<table>
<thead>
<tr>
<th>Functions that Return True or False</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=AND(B2&gt;4,C2=&quot;FedEx&quot;)</td>
<td>This will format the highlighted cells only when the contents of column B is greater than 4 and the contents of column C is &quot;FedEx&quot;.</td>
</tr>
<tr>
<td>=OR(A1=&quot;Disney&quot;,A2=&quot;Touchstone&quot;)</td>
<td>This will format the highlighted cells only when the contents of a cell in column A is either Disney or Touchstone.</td>
</tr>
<tr>
<td>=IsBlank(B1)</td>
<td>This will format the highlighted cells only when they are blank.</td>
</tr>
<tr>
<td>=IsNumber(A1)</td>
<td>This will format the highlighted cells only when one contains a number.</td>
</tr>
<tr>
<td>=IsText(A1)</td>
<td>This will format the highlighted cells only when one contains a label.</td>
</tr>
</tbody>
</table>

Note that while the formulas name a specific cell, the cell is just a place holder. Each cell address in the highlighted area will individually be substituted into its place and evaluated --- unless you create absolute references with the $.

Note also that the same cell can contain multiple formatting rules.

Methods of Creating Custom Formatting
Excel provides three methods of creating conditional formatting:
   • Build-in formatting rules.
   • Built-in formula based rules.
   • Custom formula based rules.
Clearing / Managing Rules

Before we create some rules, it might be helpful to first know how to clear and manage the rules you will be creating.

1. From the menu, click "Home – Conditional Formatting – Manage Rules".

- **Display Rules**: Use this to display the rules on a specific sheet or a selected area.
- **Resolve Conflicts**: Rules are in conflict if two different rules assign the same type of formatting to the same cell(s) (e.g. both are assigning a background). When this happens, the rule higher on the list takes precedence. You can use these arrows to move conflicting rules up or down in precedence. Note that one rule assigning a font color and another assigning a background color to the same cell would not be in conflict because the formatting is not the same. *

![Conditional Formatting Rules Manager](image)

- **New Rule**: Click this to create a new rule.
- **Edit Rule**: To edit an existing rule, click it from the list and then click "Edit Rule".
- **Delete Rule**: To delete an existing rule, click it from the list and then click "Delete Rule". This removes the conditional formatting as well.
- **Stop If True**: This is only used if you wish to simulate compatibility with earlier versions of Excel that didn’t allow more than three rules.

* Note that if there is a conflict between manual formatting and conditional formatting (e.g. manual formatting makes text green but conditional formatting makes text red), conditional formatting takes precedence.
Simple Build-in Rules – Conditions Assumed from Highlighting

The simple built-in rules will format the selected cells based on a choice of criteria that you select from a menu. Formulaic comparisons are based upon all of the cells highlighted. For example, you wish to format cells in a block if they are average. Excel calculates the average using all of the cells in the highlighted block. The only way to change how the formula is calculated when a large block is selected is to create the conditions row-by-row or column-by-column basis and then use the Format Painter to apply the formatting to the other rows or columns one-by-one.

Example 1: Color cells containing duplicate Student IDs
In this example, we wish to color any cells containing duplicate Student IDs. See later examples on how to highlight the entire row.

1. Go to the "Students" sheet.
2. Highlight the Student IDs (A2:A24).
3. Click "Home – Conditional Formatting – Highlight Cells Rules – Duplicate Values".
4. Select "Duplicate" from the drop down. ("Unique" also available.)
5. Select a formatting option.
6. Click "OK".

Example 2: Color Profits that are in the Top 10%
In this example, we will highlight any cells whose profit is in the top ten percent. See later examples on how to highlight the entire row.

1. Go to the "Movies" sheet.
2. Highlight the profits (or click the column letter "E" to highlight the entire column).
3. Click "Home – Conditional Formatting – Top/Bottom Rules – Top 10%”.
4. Specify the desired formatting options and click "OK".
Simple Built-in Rules: Using Constants: Numeric or Text

This section covers how to format cells based on a numeric or text value. The condition will apply to all highlighted cells.

**Example 3: Using a Text Constant as a Condition**

We wish to color any cell that has room "HOH415" listed. Note that in another example we will highlight any cell that has the same room listed at the same time (i.e. in the same row.)

1. Click the "Room_Assignments" sheet.
3. Click "Home – Conditional Formatting – Highlight Cells Rules – Text that Contains". ("Equal to" works too.)
4. In the box type: **hoh 415**
   (It is not case sensitive.)
5. Select a format.
6. Click "OK".

**Example 4: Using a Numeric Constant as a Condition**

In this example we wish to color any profit greater than 50 million.

1. Go to the "Numeric_Constant" sheet.
2. Highlight B4:M12
3. From the menu click: "Home – Conditional Formatting – Highlight Cells Rules – Greater Than".
4. In the box type: **50**
5. Select a format and click "OK".
Built-in Rules – Using Dynamic Conditions

In this section we will examine situations where the conditions are dynamic. That is, the criteria we are using to determine whether to format or not can change if the values in the cells change. For example, we will color cells whose value is greater than the average of the cells in the block. Rather than specifying constant value for the average (e.g. "67"), Excel will calculate the average for us based on the values in the block. If we type different values in the cells, the average will recalculate and the formatting may change.

Note that even if you are not using a dynamic condition, Conditional Formatting is always dynamic. Should you change the value in a cell, its formatting may change regardless of whether or not the condition itself employs a constant (e.g. "67") or dynamic formula (e.g. Average()).

Example 5: Color Cells Above Average

In this example, we wish to color all profits that are greater than the average profit (i.e. the average of C4:N12). We could just use greater than 67 which at the moment is the average profit; however, we wish this to be dynamic so that if different values are typed in the cells and the average profit changes, the highlighting will automatically change as well. Therefore, we will use Excel’s "Above Average" rule.

1. Go to the sheet "Above_Average_All".
2. Highlight all the profits (C4:N12).
3. From the menu click "Home – Conditional Formatting – Top/Bottom Rules – Above Average".
4. Specify the desired formatting and click "OK".

Note that this is coloring cells whose value is greater than the average value of all of the cells you highlighted. The built in formulas apply the formatting to the area you highlight and also assume to use the same highlighted area when doing their calculations.
Using the Format Painter to Copy Rules

When you use Excel's "Above Average" rule as we did above, it formats the selected cells and assumes it should compute the average using the values in the selected cells. What if we would like to highlight cells where the average profit pertains to each specific company rather than all companies or highlight profits above average for each month? There are three approaches to handling this:

- Create a new rule for each column or row. (Very time consuming.)
- Create a rule for one column or row and then carefully use the format painter to apply it to the remaining columns or rows. (Covered in this section.)
- Using Cell Addresses and a Conditional formula. (Covered in the next section.)

Example 6: Using the Format Painter to Apply Rules to other Columns or Rows

In this example, for each month we wish to color those profits that are greater than the average for that month. Because Excel's built-in "Above Average" rule assumes the average is computed using the cells you highlighted for formatting, we will need to start by only highlighting the data for a single month.

1. Go to the "Above_Average_Monthly" sheet.
2. Highlight the profits for January (C4:C12).
3. From the menu, click "Home – Conditional Formatting – Top/Bottom Rules – Above Average".
4. Select a format and click "OK".

This highlights any of the January profits that are greater than January's average profit of 65.

At this point we could use the same procedure for each of the remaining columns but making a new rule for each column would be time consuming. Instead we will use the Format Painter to copy the formatting; however, you have to do this in a very specific manner or you will get the wrong results. **You must apply it to each column one at a time!** There are a couple of ways to do this; we will use the method that is the least time consuming.

5. Highlight the profits for January (C4:C12). These are the formats we are going to copy.
6. Click the "Home" tab.
7. Double click the Format Painter button. (Double clicking it makes it say on for multiple copies.)
8. Individually click each one of ACME’s profits (i.e. click D5, then E5, then F5 and so on.) Do NOT click and drag!
9. Press "Escape" to turn off the Format Painter.
Example 7: Using the Format Painter to Copy a Rule to Find Overbooked Rooms

In this example of using the Format Painter to copy conditional formatting, we wish to color any cell in the same row that is a duplicate. Specifically, we wish to make sure we have not schedule a room to be used by two different people at the same time.

1. Go to the "Scheduling_Conflict" sheet.
3. From the menu, click "Home – Conditional Formatting – Highlight Cells Rules – Duplicate Values".
4. Select a format and click "OK".
5. Re-highlight the 8am rooms (B2:E2).
6. From the menu, click "Home".
7. Double click the Format Painter button. (Double clicking it makes it say on for multiple copies.)
8. Individually click each of the following cells: B3 then B5 and then B6. (DO NOT CLICK AND DRAG!)
9. Press "Escape" to turn the Format Painter off.

It is now clear that we have double booked BRI 202A at 2pm.

Note that when you use the Format Painter to apply rules, you are actually copying a rule and thus making new rules. The example above resulted in four separate rules.
Conditional Formatting using Cell Addresses and Simple Formulas

You can also use formulas to control conditional formatting. When doing so, there are several characteristics you need to be aware of.

- **True or False** – The formula must return *True* or *False*. For example, A10>7, B12=H12. The formatting will only be applied when the formula returns *True*.

- **Highlighting Multiple Cells Works when Correctly Combined with Relative & Absolute Addressing** - Depending on how you construct your formulas, you can highlight multiple cells and apply all formatting at once rather than having to use the Format Painter (although you can still use that too).

- **Formulas can Refer to Cells in Non-Highlighted Area** - Formatting is applied to the highlighted area but the condition does not have to be within the highlighted area.

- **Formulas can be relative or Absolute**:
  - **Absolute** – When you use absolute referencing, the condition is always evaluated based on a specific, unmoving cell address. For example, if you type: =$B$5>10 then regardless of where you apply the formatting it will always use B5 in its comparison. However, absolute referencing does not have to include both the column and the row. If you type: =$B5>10 (note there is no $ before the 5) then the condition could be any row in column B. (See the example below for more on this.)
  - **Relative** - This allows the cell addresses to shift. See the example below for an explanation.

**Example 1: How Referencing Works with Conditional Formatting Formulas**

We wanted to type an animal A1 and have that animal color in wherever it might appear in the table below. We created the following conditional formula: =C3=A1 with C3:E6 highlighted where C3 as the active cell.

We thought this would equate to: *The contents of the current cell equal to the contents of A1.*

As you can see, it only worked correctly for C3 and seemingly E5. It did not work for F3. They key to understanding what happened is realizing that Excel is shifting the cell references relative to C3, A1, and the position of the current cell.

When we initially highlighted our range the active cell was C3 and our conditional formula was =C3=A1. Because the active cell and the cell in the formula were both C3, Excel sees this as "Check in the current cell." And because A1 is two rows up and two columns to the left of C3, it sees the entire statement as: "Check the current cell against the cell two rows up and two columns to the left of the current cell." The problem is, Excel remembers this same road map for all the other cells: *Look two rows up and two columns to the left of the current position.*

C3 is working. It goes up two rows and left two columns from the current position and finds "Lion" in A1.

F3 is looking in cell D1 which does not contain "Lion". (Up two rows and left two columns from the current position (F3).

E5 appears to be working but it is really picking up "Lion" from C3. (Up two rows and left two columns from the current position (E5).
Solution
We need a formula that states: From the current position to cell A1. We can do this by making A1 absolute. This formula will work as long as when we initially highlight C3:F6 with C3 as the active cell:  \( =C3=A1 \)

If F6 were the active cell, Excel would read this as: "From the current position (F6), go up C3 and compare that against what is in cell A1. Structurally this would equate to: From the current position go up 3 and left three and compare that against what is up 5 and left 5." Again, you would get the wrong answers. If you wish to have Excel use the current cell in the comparison, then the cell representing the current cell in your formula cell must be the active cell when you highlight and it must be relative.

1. Go to the "Animals" tab.
2. Highlight C3:F6. (Start with C3 so it is the active cell.)
3. From the menu, click "Home – Conditional Formatting – New Rule".

4. Click "Use a formula to determine which cells to format" as the rule type.
5. Type the following for the rule:  \( =C3=A1 \)
6. Click the "Format" button and specify a fill color.
7. Click "OK".

Only "Lions" should highlight. Note that if you change the contents of A1 to something else like "Cat" then the highlighting will automatically change.
Example 2: Color Drops in Profit (Relative Addressing)

In this example, we wish to color the profits for the months that are less than the profits for the previous month. For this to work, we will need to do the following:

- **Logic** - Our current cell must be less than the cell immediately to its left: Current Cell < One Cell to Left
- **Relative Addressing** – Because addressing needs shift for both the current cell and the cell to its left, all addressing must be relative.
- **Formula** – the formula will be: =C4<B4
- **Highlighting** – When we highlight, the active cell must be the current cell used on our formula. (i.e. C4 is our current cell in our formula so C4 must also be the active cell when we highlight.

1. Go to the sheet "Drop_In_Profit".
2. Starting with C4, highlight C4:M12. (C4 must be the active cell.)
3. From the menu, click "Home – Conditional Formatting – New Rule".
4. Select "Use a formula to determine which cells to format" as the rule type.
5. For the rule, type: =C4<B4
6. Click "Format" and select a fill color.
7. Click "OK" then "OK" again.

**Note:**
If you highlighted the same, would "=D4<C4" work? The answer is no. Again, because C4 is the active cell when you highlighted and D4 is one cell to the right of the current cell, Excel interprets this as "Is one cell to the right (D4) of the current cell (C4) less than the current cell? (C4)"

It is always a good idea to make the cell you wish to get highlighted the first cell you name in your equation and the cell you start with when highlighting.
Example 3: Color a Company's Highest Profit (Mix of Relative & Absolute Addressing)

In this example, we will use the Max() function and a mix of relative and absolute addressing to make a formula that highlights each company's highest profit. For this to work, we will need to do the following:

- **Logic** - Our current cell must be equal to the largest cell in the same row. Because the max() function returns the largest value in a given range, we can use something like this: \( \text{=Current Cell} = \text{Max(value in same row)} \)
- **Addressing** – The current cell represents every cell in our table and therefore needs to be relatively addressed. Max needs to be able to move down but not left or right; therefore, the row numbers need relative and the column letters need to be absolute: Max($B4:$M4).
- **Formula** – The finished formula is: \( \text{=B4=Max($B4:$M4)} \)
- **Highlighting** – When we highlight, the active cell must match the current cell in our formula and the current row in Max() must match the active row when we highlight; so, B4 must be the active cell when we highlight.

Note that we could also use the "Top 10 Rule" (change 10 to 1) on the top row and then use the Format Painter apply it to the other rows but with larger spreadsheets formulas are faster than using the Format Painter.

1. Go to the sheet "Company_Max_Profit".
2. Highlight B4:M4. (Make sure B4 is the active cell.)
3. From the menu, click: "Home – Conditional Formatting – New Rule".
4. Select "Use a formula to determine which cells to format" as the type of rule.
5. For the rule type: \( \text{=B4=Max($B4:$M4)} \)
   (Note that if there is a tie in the same row, both values will be highlighted.)
6. Click "Format" and select a fill color.
7. Click "OK" then "OK" again.
Example 4: Color Entire Row where Company Average Greater than overall Average

In this example we will take a look at how to highlight an entire row rather than just the cell containing the matching item. Specifically, we wish to highlight a company and its profits if its average is greater than the average for all company's in the table. (Note that you can't do this with the "Above Average" rule.)

1. Go to the "Row_Above_Average" sheet.

   (Make sure the active cell is somewhere in the top row.)

3. From the menu, click "Home – Conditional Formatting – New Rule".

4. Select "Use a formula to determine which cells to format" as the rule type.

5. For the rule, type:
   \[=\text{Average}($B4:\text{M}4) > \text{Average}(\text{B4:}\text{M}12)\]

6. Click the "Format" button and select a fill color.

7. Click "OK" then "OK" again.

Notes:

- The first part of our equation \[=\text{Average}($B4:\text{M}4)\] freezes the columns but allows the rows to shift. For this to work, when we initially highlight, our active cell must be somewhere in row 4.
- Note that this highlights the entire row because highlighted the entire row and we didn't name a single cell that Excel could highlight instead.
Example 5: Color Rows Where Shipped Date is After Required Date

In this example, we wish to color the entire row if an order is going to be late; specifically, when the Shipped Date is after the Required Date. Note that Excel sees dates as numbers that get progressively larger as the years go by so we are looking for Required Dates that are less than Shipped Dates.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Order ID</td>
<td>Company Name</td>
<td>Billing Address</td>
<td>Ship Address</td>
<td>Order Date</td>
<td>Required Date</td>
</tr>
<tr>
<td>2</td>
<td>12 Wellington Trading</td>
<td>16 Newcomen Rd.</td>
<td>16 Newcomen Rd.</td>
<td>5/25/2012</td>
<td>6/20/2012</td>
<td>6/18/2012</td>
</tr>
<tr>
<td>3</td>
<td>6 Walnut Grove Grocery</td>
<td>33 Upper Arctic Dr.</td>
<td>33 Upper Arctic Dr.</td>
<td>5/15/2012</td>
<td>5/27/2012</td>
<td>5/25/2012</td>
</tr>
<tr>
<td>4</td>
<td>21 Vine and Barrel, Inc.</td>
<td>12405 Aurora Ave. N. Suite 200</td>
<td>8350 - 10th Ave. NE</td>
<td>6/5/2012</td>
<td>6/15/2012</td>
<td>6/16/2012</td>
</tr>
<tr>
<td>5</td>
<td>5 ValuMax Food Stores</td>
<td>P.O. Box 10029</td>
<td>986 Chandler Dr.</td>
<td>5/12/2012</td>
<td>5/24/2012</td>
<td>5/22/2012</td>
</tr>
<tr>
<td>6</td>
<td>20 Valley Store</td>
<td>1114 S. 3rd St. Suite 1A</td>
<td>1114 S. 3rd St. Suite 1A</td>
<td>6/7/2012</td>
<td>7/2/2012</td>
<td>6/30/2012</td>
</tr>
<tr>
<td>7</td>
<td>24 Tommy's Imported Specialties</td>
<td>Thompson Building 348 - 33rd St.</td>
<td>Thompson Building 348 - 33rd St.</td>
<td>6/14/2012</td>
<td>6/19/2012</td>
<td>6/17/2012</td>
</tr>
<tr>
<td>8</td>
<td>7 Fred's Edibles, Etc.</td>
<td>1522 College Blvd.</td>
<td>1522 College Blvd.</td>
<td>5/17/2012</td>
<td>6/5/2012</td>
<td>6/3/2012</td>
</tr>
<tr>
<td>9</td>
<td>3 Foodmengers, Inc.</td>
<td>418 - 6th Ave.</td>
<td>418 - 6th Ave.</td>
<td>5/10/2012</td>
<td>6/7/2012</td>
<td>6/5/2012</td>
</tr>
<tr>
<td>10</td>
<td>22 Empire Trading</td>
<td>7 Baxter Hill</td>
<td>7 Baxter Hill</td>
<td>6/10/2012</td>
<td>6/22/2012</td>
<td>6/21/2012</td>
</tr>
</tbody>
</table>

1. Go to the "Orders" sheet.
2. Highlight A2:G27. (Note that a cell in row 2 must contain the active cell for this to work.)
3. From the menu, click "Home – Conditional Formatting – New Rule".
4. Select "Use a formula to determine which cells to format" as the rule type.
5. For the rule, type: 
   =$F2<$G2
   (i.e. Required Date before Shipped Date)
6. Click the "Format" button and select a fill color.
7. Click "OK" then "OK" again.

Notes:
- The column letters in our formulas were absolute so that Excel stays within the Order Date and Required Date columns when making its comparison. This was necessary because we Excel will evaluate every cell within the highlighted area unless you specify otherwise. The row numbers are relative because we want Excel to check every row.
Example 6: Color Alternating Rows
In this example we will use the Mod() and row() functions give a background fill to alternating rows. To do this, we need to remember that the formatting only takes place if the equation we use returns "True" so we need to make an equation or function that returns True or False. We can do this by creating an equation that returns 0 for even rows and 1 for odd rows. (Excel interprets 0 as "False" and 1 as "True").

Row(Cell Address)
This function returns the row number of a given cell address. For example, =Row(A2) returns 2. If we divide each row number by 2, we will get whole numbers for all of the even rows and fractions for the odd rows. (e.g. 2/2=1, 4/2=2, 6/2=3 are all whole numbers and 1/2=1/2, 3/2=1&1/2, 5/2=4&1/2 are fractions.)

Mod(Number,Divisor)
This function divides one number by another and returns the remainder. For example, if we divide the row numbers by 2, we get a remainder of 1 for all odd row numbers and a remainder of 0 for all even row numbers.

<table>
<thead>
<tr>
<th>Odd Row</th>
<th>Even Row</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 3 2</td>
<td>2 5 2</td>
</tr>
<tr>
<td>-2 -2</td>
<td>-2 -4</td>
</tr>
<tr>
<td>1 1</td>
<td>0 0</td>
</tr>
</tbody>
</table>

Putting it all together, we will use Row() to extract the row number and Mod() to return its remainder when divided by 2. For the odd rows our equation will return 1 which Excel sees as "True" and therefore formats the cells. For the even rows our equation will return 0 which Excel sees as "False" and therefore does not format the cells. The completed equation is:

=Mod(Row(A2),2)

1. Go to the "Alternating_Rows" sheet.
2. Highlight A2:F54 where A2 is the active cell.
3. From the menu, click "Home – Conditional Formatting – New Rule".
4. Select "Use a formula to determine which cells to format" as the rule type.
5. For the rule, type: =Mod(Row(A2),2)
6. Click the "Format" button and select a fill color.
7. Click "OK" then "OK" again.

Note that if you wanted to highlight the even rows, you could use: =Mod(Row(A2)+1,2)
Example 7: AND & OR Conditions

To create compound conditions, you can use either the AND() or the OR() function. They both return either True or False based on one or more conditions.

**AND(Condition1,Condition2,Condition3, etc.)**

This will return True only if all of its conditions is true. If any one of them is false it will return False.

For example: =AND(C2="R",D2="Comedy") will only return True if both of these conditions are met.

**OR(Condition1,Condition2,Condition3, etc.)**

This will return True only if any one of its conditions is true. It will only return False if all of them are false.

For example: =OR(C2="R",D2="Comedy") will return True if either one of these conditions is met.

We wish to color rows where the Rating is "R" AND the Category is "Comedy".

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Production Co</td>
<td></td>
<td>Movie</td>
<td>Rating</td>
<td>Category</td>
</tr>
<tr>
<td>2</td>
<td>Touchstone</td>
<td>Deceived</td>
<td>R</td>
<td>Drama</td>
<td>$45,200,389</td>
</tr>
<tr>
<td>3</td>
<td>20th Century Fox</td>
<td>The Commitments</td>
<td>R</td>
<td>Drama</td>
<td>$49,876,300</td>
</tr>
<tr>
<td>4</td>
<td>Universal</td>
<td>Fried Green Tomatoes</td>
<td>R</td>
<td>Drama</td>
<td>$50,879,690</td>
</tr>
<tr>
<td>5</td>
<td>United Artists</td>
<td>The Jerk</td>
<td>R</td>
<td>Comedy</td>
<td>$54,900,890</td>
</tr>
<tr>
<td>7</td>
<td>Tri Star</td>
<td>The Fisher King</td>
<td>R</td>
<td>Drama</td>
<td>$65,400,397</td>
</tr>
</tbody>
</table>

1. Go to the "AND_OR_Conditions" sheet.
2. Highlight A2:F54. (Make sure the active cell is in row 2.)
3. From the menu, click "Home – Conditional Formatting – New Rule".
4. Select "Use a formula to determine which cells to format" as the rule type.
5. For the rule, type:  
   =AND($C2="R",$D2="Comedy")
6. Click the "Format" button and select a fill color.
7. Click "OK" then "OK" again.
Range Segments – Applying Multiple Conditions to the Same Cells

Excel will allow you to apply multiple conditions to the same cell(s). As long as these conditions apply a different type of formatting (i.e. one rule makes text bold and the other colors the background) both rules will apply as appropriate. However, when you are applying the same formatting type (e.g. fill color) to the same cells, depending upon the condition there may be conflict. Excel resolves these conflicts by having the rules higher in the Rules Manager take precedence over the rules below them. This allows us to apply formatting based upon ranges of numbers.

Example

In this example, we wish to apply background colors to average temperatures as shown below:

<table>
<thead>
<tr>
<th>Range</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 33°</td>
<td></td>
</tr>
<tr>
<td>Between 32° and 45°</td>
<td></td>
</tr>
<tr>
<td>Between 46° and 60°</td>
<td></td>
</tr>
<tr>
<td>Between 61° and 75°</td>
<td></td>
</tr>
<tr>
<td>Between 76° and 90°</td>
<td></td>
</tr>
<tr>
<td>Above 90°</td>
<td></td>
</tr>
</tbody>
</table>

The trick to using multiple conditions is to remember that Excel evaluates a cell’s contents starting with the top rule. If that top rule returns "True", then no other rules that use the same formatting type for the current cell are applied. This means that we need to create our ranges using either of these to configurations:

- For rules using the smallest breakpoints at the top, the condition should be: \(< \text{Smallest Break Point}\) (For example, B3<33, B3<45, B3<60, B3<75, B3<90, B3>=90)
- or
- For rules with the largest breakpoints at the top, the conditions should be: \(> \text{Largest Break Point}\) (For example, B3>=90, B3>75, B3>60, B3>45, B3>33, B3<=32)

1. Go to the "Temperatures" sheet.
2. Highlight B3:F12. (Be sure to start with B3 so it is the current cell.)
3. From the menu click "Home – Conditional Formatting – Manage Rules - New Rule".

Rule for Below 33°

4. Click "Use a formula to determine which cells to format".
5. For the formula, type: \(=\text{B3}<33\)
6. Click the "Format" button and select a grey fill color for the cell.
7. Click "OK" but don’t close the Manage Rules window.

Note that this is probably easier with "Color Scales" but they are limited to a max of 5 conditions.)
Rule for below 45
You should still be in the Manage Rules window. If not, be sure to re-highlight the area with B3 as your current cell.

8. Click "New Rule".
9. Click "Use a formula to determine which cells to format".
10. For the formula, type: =B3<33
11. Click the "Format" button and select a grey fill color for the cell.
12. Click "OK" but don't close the Manage Rules window.

Rule for below 60
You should still be in the Manage Rules window. If not, be sure to re-highlight the area with B3 as your current cell.

13. Click "New Rule".
14. Click "Use a formula to determine which cells to format".
15. For the formula, type: =B3<60
16. Click the "Format" button and select a green fill color for the cell.
17. Click "OK" but don't close the Manage Rules window.

Rule for below 75
You should still be in the Manage Rules window. If not, be sure to re-highlight the area with B3 as your current cell.

13. Click "New Rule".
14. Click "Use a formula to determine which cells to format".
15. For the formula, type: =B3<75
16. Click the "Format" button and select a yellow fill color for the cell.
17. Click "OK" but don't close the Manage Rules window.

Rule for below 90
You should still be in the Manage Rules window. If not, be sure to re-highlight the area with B3 as your current cell.

13. Click "New Rule".
14. Click "Use a formula to determine which cells to format".
15. For the formula, type: =B3<90
16. Click the "Format" button and select an orange fill color for the cell.
17. Click "OK" but don't close the Manage Rules window.
Rule for $\geq 90$
You should still be in the Manage Rules window. If not, be sure to re-highlight the area with B3 as your current cell.

13. Click "New Rule".
14. Click "Use a formula to determine which cells to format".
15. For the formula, type: $=B3\geq90$
   (Note that $\leq200$ or another large number would also work)
16. Click the "Format" button and select a red fill color for the cell.
17. Click "OK" but don't close the Manage Rules window.

Ordering the Rules
If you click "Apply" at this point, you may notice that the formatting is not being applied as desired. This is because we still need to order the rules correctly.

18. Select each rule and use the up/down arrows to position them as shown in the image below. The rules should be ordered with the lower ranges towards the top of the list.
19. Once ordered correctly, click "Apply" to verify and then "OK".
Icon Sets, Data Bars, and Color Scales

Somewhat similar to Sparklines, Icon Sets, Data Bars, and Color scales visually differentiate cells through the use of icons, colors, and small graphs; however, they are a type of Conditional Formatting and thus are dynamic and affect the cells highlighted. Note that while you can use formulas in combination with Icon Sets, Data Bars, and Color Scales, referencing must be absolute. **Relative referencing is not permitted.**

Data Bars

Data Bars will partially shade a cell based on the value within the cell.

**Example: Data Bars for Grades**
1. Click the "Grades Databars" sheet.
3. From the menu, click "Home – Conditional Formatting – Data Bars".
4. Select one of the color (gradient or solid) examples.

If you would like to make the bars look a little more pleasing, there are a few options.
In the example on the upper right, we did the following:
- Made the score numbers white.
- Centered the scores vertically and left aligned them.
- Made the bars solid.
- Widened column B and the rows.

**Editing a Rule**
To make the bars a darker color, do the following:
1. Click anywhere within the area you formatted.
2. Click: "Home – Conditional Formatting – Manage Rules".
3. Make sure the rule you created is highlighted and select "Edit Rule".
4. You can change bar and border color in the "Bar Appearance" section.

Note you can also change the direction of the bars align to the right by using "Bar Direction".
Icon Sets

Icon Sets place symbols within the same cells whose values they are evaluating. The symbols typically vary in color within range they are applied to based upon the cell value and the number of symbols in the set. For example, if you select an icon set containing 3 symbols then the numbers will be divided into 3rds based on the their value. So, if you have numbers 1-9 then 1-3 might get red, 4-6 might get yellow, and 7-9 might get green. The number of color variations available within an icon set can range from 2 to 5.

Example:  Three Symbol Set - Customer Rank Based on Account Balance

In this example, we wish to mark any customer with a negative balance with a red symbol, balances between 0 and 2500 with green, and customers with a balance over 2500 with yellow.

1. Go to the sheet "Icon_Set_Balance".
2. Highlight the Account Balances (B2:B14).
3. From the menu, click "Home – Conditional Formatting – Icon Sets".
4. Select the one with 3 circles.

Because we selected a three icon set, Excel gave numbers above 67% green, below 33% red, and between them yellow. We will now need to adjust our scale in accordance with our desired outcome.

5. Click any one of the cells containing an icon.
6. From the menu, click "Home – Conditional Formatting – Manage Rules".
7. Select the rule we just made from the list and then click the "Edit Rule" button.

The default range setup is shown to the left. We need to change the icon display color, the values, and type. See the next page for the completed changes.
12. Click "OK".

The icons should be distributed as shown.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Customer Name</strong></td>
</tr>
<tr>
<td>2</td>
<td>Homer Simpson</td>
</tr>
<tr>
<td>3</td>
<td>Marge Simpson</td>
</tr>
<tr>
<td>4</td>
<td>Apu</td>
</tr>
<tr>
<td>5</td>
<td>Dr. Hibbard</td>
</tr>
<tr>
<td>6</td>
<td>Moe Sitzlack</td>
</tr>
<tr>
<td>7</td>
<td>M. Burns</td>
</tr>
<tr>
<td>8</td>
<td>Dr. Nick Riveria</td>
</tr>
<tr>
<td>9</td>
<td>Moleman</td>
</tr>
<tr>
<td>10</td>
<td>Selma</td>
</tr>
<tr>
<td>11</td>
<td>Patty</td>
</tr>
<tr>
<td>12</td>
<td>Waylon Smithers</td>
</tr>
<tr>
<td>13</td>
<td>Sideshow Bob</td>
</tr>
<tr>
<td>14</td>
<td>Krusty the Clown</td>
</tr>
</tbody>
</table>
Color Scales

Color Scales allow you to transition from one color to another based upon the cell values within the range you are applying the colors to. Color scales can be based on two or three colors. When creating a two color scale, you will assign a color to a minimum value and a different color to a maximum value. Excel will then evenly transition through the spectrum between the two colors. When creating a three color scale, you also have a mid-point color that allows you to control where the transition occurs. For example, if you are transitioning between blue and green, you can use the midpoint value to show more blue or more green.

**Example: Three Color Scale**

In this example, we will transition from red (minimum values) to blue (maximum values) and have a yellow midpoint based at the average. We could base the midpoint on the actual average of 80.9 but we will use the average() function to determine the midpoint for us.

1. Go to the sheet "Color_Scales".
3. From the menu, click "Home – Conditional Formatting – Color Scales".
4. Select any of the color scales.

We now must adjust our color scale to reflect a three color transition.

5. Click any of the formatted cells. (B3 for example.)
6. From the menu, click "Home – Conditional Formatting – Manage Rules".
7. Click "Edit Rule".
8. Make the changes shown below and click “OK” then “OK” again.

![Image of the Excel interface showing how to edit a color scale rule]

**Minimum**

We want the smallest value in our range to be red.

- Set “Type” to “Lowest Value”.
- Set “Value” to “Lowest Value”.
- Set “Color” to red.

**Midpoint**

We want our midpoint occur at the average value and its color to be yellow.

- Set “Type” to “Formula”.
- Set “Value” to:
  ```excel
  =Average($B$2:$B$15)
  ```
- Set “Color” to yellow.

**Maximum**

We want the largest value in our range to be blue.

- Set “Type” to “Highest Value”.
- Set “Value” to “Highest Value”.
- Set “Color” to blue.